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Lesson 4
Library Project: FLOOR PLANS - Part 2::

In this lesson you will continue to develop your floor plan for the Campus
Library project; in the previous chapter you drew the walls, doors, windows
and columns/grids. Throughout this lesson you will be introduced to a few
new commands and design concepts. Specifically, you will add stairs,
elevators, toilet room fixtures and casework.

The image below is another reminder of what your plan will look like when
you finish Lesson 5. Notice, again, the classrooms in the lower-right, the
office area in the upper-left, the main toilet rooms in the lower-left, the
public concourse across the top, and the check-out area in the middle.

It is important to remember that your drawings are to comply with the “office
standards” outlined in Appendix A; this includes layer naming conventions,
lineweight standards (which are based on the lines color), dimension and text
standards, dimscale and Itscale settings, and abbreviations. As previously
mentioned, this is intended to simulate a real-world office environment.
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Overview: Example of what will be drawn in this book - First Floor Plan
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Toilet Room Layout

Introduction

There are several important factors in laying out a toilet room. The primary
consideration is typically accessibility; that is complying with local, state and
federal accessibility codes so that people with various handicaps can easily
access and use the toilet room facilities (or the entire building in general).

Other considerations include sight-lines. It is undesirable for a person in the
hallway to see any of the toilet fixtures when the door is being opened by
someone entering that space. It should be obvious that privacy (especially
between males and females) should be expected in a toilet room design.
Seeing the sinks (i.e., people washing their hands) is not too bad but the
designer needs to make sure the sight-lines are not extended by the mirror
above the sink. The design techniques employed to impede improper sight-
lines often takes up a fair amount of floor space.

Another consideration has to do with the plumbing fixtures. It is important to
have the correct type of fixture drawn and have it drawn the correct size.
Some of the code requirements are based on the clear space in front of the
fixture; thus, the fixture needs to be the correct size in order to verify
compliance. Also, whether the fixture is wall-hung or a floor mounted tank-
type fixture is important; the mechanical engineer needs to know (they
specify the fixture in the Project Manual). If the toilet is wall-hung the wall
needs to be thick enough to conceal the support bracket and the plumbing
(the wall is even thicker when two toilets are back-to-back). From a Designer
stand point, wall-hung toilets are often desirable in commercial buildings
because they are easy to clean under and can be equipped with automatic
flushing to help ensure a better “space experience” for everyone!

Downloading Content from the Internet

In the next several steps you will get a better understanding of how you can
get CAD content from the internet to use in your drawings.

A word of warning before proceeding:

Do not assume all CAD content found on the internet is worthy
of using in your drawings. There are many locations on the web
where individuals have uploaded CAD drawings that are less
than perfect, so use caution. On the other hand, if you are
downloading content from a product manufacturer’s website,
you can be fairly confident that they have accurately drawn their
own product and want you to have a successful project using
both their product and CAD files!
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In this exercise you will be instructed on how to download toilets, sinks and
drinking fountains from a plumbing manufacturer’s website. The AutoCAD
drawing files you download will be saved to your hard drive and then inserted
using the Insert [block] command.

In an office setting you might want to save the downloaded plumbing fixture
drawings to a “Plumbing Fixtures” folder on your hard drive for convenient
access in the future.

You will need to have access to the internet for the next several steps...

1. Open your Internet Browser; this book uses MS Internet Explorer.

Next you will be instructed to browse to a major plumbing manufacturer’s
website.

2. Browse to the Kohler website by entering the URL www.kohler.com
and then press Enter... or click Go.

KOHI.E.

v

[Done @ Internet

Figure 4-1.1 Website: www.kohler.com

FYI: As you should be well aware, websites can change at any given moment.
Companies often update their websites as new content becomes available or a fresh
new look is desired. Even the model numbers change from time to time. So if the
screen shots shown here are different than what you see on your screen you will
have to interpret the steps based on what you see; you will likely still have access to
the same content.

3. Click on Kitchen and Bath and then click in the textbox next to
Search at the top of the webpage; type k-4329 and press Enter.

4. Click directly on the toilet image (the one without the bedpan lugs)
(see Figure 4-1.2).
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The Art of the Faucet

nnnnnn

Figure 4-1.2

Take a minute to review the features
of this toilet fixture.

5. Near the center-bottom of the
page, click TECHNICAL
INFORMATION and CAD
FILES

The previous step expands the
webpage to show more information
(see Figure 4-1.3).

Website: www.kohler.com; search results

(Z KOHLER: K-4329; Kingston™ elongated wall-hung bowlwith rear spud; Toilets; Fixtures; Bathroom - Microsoft Internet Explorer, pr
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Kingston™ elongated wall-hung bovs with rear spud, less seat
Precision-engineered to meetthe challenging demands of
today's commercial bathrooms, the Kingston wall-hung toilet
features an elongated bowl and is available in a palette of
KOHLER colors. Coordinate the bathroom with a Kingston
lavatory.
= 25-5/8"x 16-3/4" x 13-1/4"
Click here to see the s
eX anded info ation from floor to top of seat or installed with (K-4679-CA) toilet seat
p List price: $195.20 and up
area, which includes the \
Specification Sheet & Measurements + PDF
Installation Instructions + PDF
Rough In Guide + PDF
Homeowners Guide / Service Parts + PDF
+ Senice Parts History
2D Plan View > DWG » DXF
2D Front View +DWG » DXF
2D Side View = DWG - DXF
2
B & @ interet 100%

Figure 4-1.3

Website: www.kohler.com; downloading CAD Files

The next link you are instructed to click will allow you to save a CAD file of
this fixture to your hard drive. If in a classroom setting, your instructor may
direct you to save these files to a different location.

6.

Under CAD Files, right-click DWG next to 2D Plan View and then

select Save Target As... from the pop-up menu.
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Make sure you selected DWG CAD Files and not DXF CAD Files. The former is
the native AutoCAD file format and the latter is a file format conceived by
Autodesk to allow designers to share CAD information between AutoCAD and
other CAD programs not written by Autodesk. The DWG file format is more
readily inserted into your current drawing than DXF (Drawing eXchange

Format).

7.

Click Save in the File Download dialog box (see Figure 4-1.4a).

FYI: You may not get this prompt; if not, skip to the next step...

File Download

Do you want to open or zave thiz fle?

Mame: 4329pin,dwg
Type: AutoCAD Drawing, 6,15 KB

From: wwww.us, kohler, com

J |

[¥] &lways ask befare opening this type of file

Open Save ]L Cancel J

X]

Wwhile filex from the Internet can be ugeful, some files can potentially
harm your computer. If pou do not tust the source, do not open or
zave thiz file. What's the rigk?

v

Figure 4-1.4a

8.

Saving a file from the internet

(Figure 4-1.4b).

Save As
Savein | ) My Documents v Q e E'
N Iy adim
:3 |[)AutaCAD Sheet Sets
My Recent | [LAukodesk
Documents |y autodesk Architectural Deskiop 2004
—= |05 Misc
L% )My Autodesk Content Browser Library
Desktop [y eBooks
éMy Tusic
s (2 My Pictures
._;‘J)j EMV Videos
o s JRE'.,SIdBnE? Project
|[Z)5tine Residence
J
Fy Metwork,
Places
File name: A4
Save as wpe: AutaCAD Drawing hd

Browse to your My Documents folder and click Save

21X

Cancel

Figure 4-1.4b Saving a file from the internet

You now have a copy of the toilet fixture on your hard drive and it is ready to

place in your floor plan!

4-5
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The file you just downloaded is named 4329pln.dwg (unless you renamed it
in the previous step); the name is the model number plus the view (pln for
plan view in this case). If you open the file directly you will notice the origin
has been conveniently located at the back/center of the fixture and all lines
are on Layer zero. Having all lines on Layer zero is preferred; this way all
lines in the Block will take on the properties of the Layer the Block is placed
on.

Next you will be instructed to download the other fixtures required for your
floor plan. Rather than giving you step-by-step instructions you will simply be
given the model numbers - you can then find and download the other
fixtures using similar techniques to those just covered.

9. Download the other two views (front and side) of the toilet.

10. Using techniques previously covered, download all three views (plan,
front and side), from the Kohler website, for the plumbing fixtures
listed below:

¢ K-2007 Kingston™ wall-mount lavatory
¢ K-5024-T Dartfield™ Urinal
e K-5250 Serra™ Drinking Fountain

When finished you should have the following files listed in your My
Documents folder:

5250sde.dwg
5250pIn.dwg
5250frt.dwg
5024tsde.dwg
5024tpin.dwg
5024tfrt.dwg

4329sde.dwg
4329pln.dwg
4329frt.dwg
2007sde.dwg
2007pIn.dwg
2007frt.dwg

Next you will draw a “lavatory system” from another major plumbing
manufacturer called Bradley Corporation. You can also download this one
from the internet (and you will be given the URL), but the file is composed of
multiple views and information, plus it is in a ZIP file, which makes for more
work (as far as this tutorial is concerned).

11. If you prefer to try the download, browse to the following URL.:
http://www.bradleycorp.com/products/fixtures/lavsystems/
ss/viewproduct.jsp?pgid=1196
(This may change,; see item "b” below.)

a. Click the link to download the CAD Files.
b. You can also search for Express Lavatory, Model SS-2N

12. In a new drawing, draw the Lavatory System shown in
Figure 4-1.5; make sure the origin is at the back and centered.
a. Approximate all dims and arcs not specified.
b. Draw everything on Layer zero.

4-6
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Figure 4-1.5 Draw this lavatory system in a new drawing file with origin centered on the back side

13. Save your drawing into the My Documents folder; name the file
Lav_System_pin.dwg.

Your new drawing file is now ready to be inserted into the floor plan drawing
when it is needed!

14. Close the lavatory drawing and Open your floor plan drawing.

You are now ready to add the plumbing fixtures to your floor plan. You will
start with the small toilet rooms near the main entry.

15. Add the plumbing fixtures as shown in Figure 4-1.6, plus:
Make sure the fixtures go on Layer A-Mech-Pfix.
See Figure 4-1.7a for the grab bar dimensions.
Draw the grab bars on Layer A-Flor-Accs.

The room on the right has a toilet, sink and urinal.
The room on the left has a toilet and a sink.

Add a drinking fountain in the hallway.

Do not draw the dimensions or the dashed lines.

@"Ppao0 oo

TIP: Select Insert from the Blocks and References tab, and then
click the Browse... button. This will allow you to select AutoCAD
drawing files from your hard drive to be inserted into the current
drawing (onto the current Layer).
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The dashed lines shown in Figure 4-1.6 represent the clear floor space that
must be considered when designing the layout of a toilet room. This tutorial
will not get into the specifics related to the clear floor space at each fixture
type; but, you may want to consider creating a special layer to place this
information on so it can be turned off when not needed.

Another technique you might consider related to clear floor space is to add
these dashed lines to your Blocks. You can leave the fixture on Layer zero
and add the dashed lines on a specific Layer. That way, when the “clear floor
space” Layer is turned off, the fixture will still be visible (as long as the
fixture was not inserted on the “clear floor space” Layer, or any other Layer
that is turned off). You will employ this technique in Lesson 5 when you
create furniture and fixture symbols (i.e., Blocks).

Figure 4-1.6 Place the fixtures shown (do not draw the dashed lines)

The sight-lines are not too bad here, considering the shape of the room
outside the toilet rooms. However, the line of sight is not as critical in this
situation because the toilet rooms are for single users. Most designers still
prefer to ensure that plumbing fixtures are not visible from adjacent rooms,
especially off of main entries and lobbies. In this case you created a small
alcove-type space where a person needs to go out of their way to be in a
position where the sight-lines matter; even a person walking straight towards
the drinking fountain will not have any sort of vantage point towards the
plumbing fixtures.
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Figure 4-1.7a Grab bar dimensions;
1 2" diameter pipe

Drawing the Large Multi-User Toilet Room

You will jump right in and place the plumbing fixtures and then you will add
the toilet partitions and review the sight-lines from the adjacent hallway. You
will also review the requirements for wall thicknesses behind the wall-hung

toilets.

16. Insert the plumbing fixtures as shown in Figure 4-1.8, plus:
a. Make sure the fixtures go on Layer A-Mech-Pfix.
b. See Figure 4-1.7a for the grab bar dimensions; see
Figure 4-1.9 for grab bar locations.
c. The northern room has (3) toilets and a Lavatory System.
d. The southern room has (2) toilets, a urinal and a Lavatory
System (obviously this is the Men’s toilet room).

Sight-lines are typically explored by drawing a line from the adjacent
hallway (or space), through the door opening, into the toilet room. Looking
at Figure 4-1.8 you can see the sight-lines are quite acceptable. As
previously mentioned this design solution takes up a fair amount of floor
space but is necessary.

An unacceptable design solution is shown in Figure 4-1.9. The toilet room is
much larger and can even have another toilet fixture without the door
modification for sight-lines; also, the door is right off the circulation path
which can be problematic. Notice two lines are shown to visualize the full
visual range. Granted, some of this view is obstructed by a person’s body as
they pass through the door opening; it is still an undesirable design solution.

4-9
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|
+ 1 -
Figure 4-1.8 Place the fixtures shown; dashed line shows sightline
/
This is the full view

range in this design
solution.

B

Figure 4-1.9

Dashed lines reveal unacceptable sightlines into the toilet room

4-10
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Adding the Toilet Partitions

The toilet partitions offer privacy for toilets and urinals. They come in a few
styles and materials. Styles range from floor mounted to ceiling hung; the
latter offers better access to cleaning the floors, like wall-hung toilets.
Materials range from pre-finished metal to Solid Phenolic Core (i.e., plastic),
to stainless steel.

The divider panels, pilasters and doors come in various thicknesses.
However, each is typically drawn 1” thick and is dimensioned to the center of
the panel so the thickness is not too important.

If you want to see images and more information on toilet partitions you can
visit the Bradley Corporation website list below (select Tech data sheet PDF):
http://www.bradleycorp.com/products/mills/floor/viewproduct.jsp?pgid=673

The example to the left shows a
floor mounted, overhead-braced
toilet partition system.

Also notice the urinal screen at the
end of the countertop.

Floor drains are usually positioned
beneath a toilet partition so users
do not have to walk over the
slightly uneven surface.

Notice the accent floor tile that also
takes into consideration the
location of the toilet partitions.

Accessibility codes offer several layout options for toilet partitions. For
example, if the door swings into the stall, more room is required in the stall
to maintain the required clear floor space for the toilet fixture. Having a
cheat-sheet of several different layout options is a big help. Consult your
local code for specifics.

The preceding image is very similar to the Men’s toilet room you are
currently working on.

17. Draw the toilet partitions as shown in Figure 4-1.10, plus:

Make sure the partitions go on Layer A-Flor-Tptn.

Use lines and arcs to draw the partitions; show all 1" thick.

Do not draw the dimensions.

Draw a 36" wide door into the end stall (i.e., Accessible Stall).
Draw 30" wide doors centered on the remaining stalls.

Draw the grab bars on Layer A-Flor-Accs.

OO0 oW
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Figure 4-1.10 Drawing the toilet partitions and urinal screen

18. Add a drinking fountain just to the
east of the Men’s toilet room, and
centered on the wall, as shown in
Figure 4-1.11.

For info on wall thicknesses behind double-hung
toilets visit: www.pdionline.org and review
the publication: Minimum Space Requirements
for Enclosed Plumbing Fixture Supports.

This concludes the toilet room floor plan
exercise. You will study this a little more in the

toilet room interior elevations tutorial later in Figure 4-1.11
this book Drinking fountain centered on wall
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Casework

Introduction

This exercise covers the basic techniques used to represent casework in plan.
Casework is typically any built-in cabinets, countertops, desks, bars, etc. and
is usually installed by a carpenter. This does not include systems furniture
which is sometimes attached to the wall.

The architectural floor plans typically show the built-in items (i.e., casework)
and the FFE Plan (furniture, fixtures and equipment) typically show the
moveable items. The FFE Plans are covered in the next chapter.

The words “typical” and “usually” are used a lot because there is no exact
science to how a set of drawings are put together. They can vary by country,
state, city and even office.

First you will draw the casework in the open office area. These upper and
lower cabinets represent the work area where copying and mailing occurs.

Work Area Cabinets

Cabinets in a work area can vary quite a bit depending on the work being
performed there. The picture below is similar to what you will be drawing
next. The base cabinets are on the floor and are typically 24" deep (but
come in a variety of depths). The wall cabinets are attached to the wall and
also come in various depths (12” and 14" being the most common).

As you can see the electrical outlets need to be coordinated with the
electrical engineer; they need to be installed above the countertop and below
the wall cabinets. When preparing the program, the designer (Architect or
Interior Designer) should get a list of all the equipment required in each
area. This will determine the number of outlets and locations. Often, items
are overlooked or added later that can create an unsafe strain on the
electrical system or require extension cords. For example, it is possible that
the microwave shown in the image below was added by the users long after
the design of the building; if the electrical system did not have enough
capacity, it could make for an unsafe condition. If that were the case, a new
outlet on another circuit would need to be added.

Notice two things about the wall cabinets: 1) The cabinets have “under-
counter lights” across the entire length. If this is desired by the
client/designer, the electrical drawings need to be coordinated and the
bottom of the cabinet recessed so the light fixture is not directly seen. 2) The
space between the top of the cabinet and the ceiling is filled in with studs and
gypsum board for a clean, dust-free finish (not always in the budget).

4-13
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Example of typical work room cabinets; see comments on previous page

1. Draw the casework shown in Figure 4-2.1, plus:
a. Base cabinet lines on Layer A-Case.
b. Wall cabinet lines on Layer A-Case-Abov.

i. Make sure you set the linetype correctly.
c. Do not draw the dimensions,

FYI:

The countertop typically extends out past the
base cabinets by an 1”. Thus, in plan, the A-Case
lines are 25” out from the wall (24” cabinet + 1”
countertop overhang = 25” countertop).

| !

Figure 4-2.1 Drawing the work area casework

4-14
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Break Room Cabinets

The cabinets in the break room have similar considerations as the work room
cabinets. Additionally, you often have plumbing to coordinate as well (e.g., a
sink or dishwasher). When drawing plans, these items are roughly placed and
then more refined later with interior elevations, then the plans are updated.

The first thing you will do, to prepare for laying out the break room counter,
is to draw a two-compartment sink.

2. In a new drawing, create the two compartment sink as specified
below (save to your My Documents folder):

filename: Sink-1.dwg

2! 9"
= Draw this sink per the following

I( )| specifications:

o 2" space (i.e., offset) at
= N sides and front.

49

_l

—

®
o0

o 3" Dia. Circles centered in
sinks.
o 2" rad. for Fillets.

o o

1'-10"

A A g o 1 %" Dia. at faucet
1 |_2 ' spaces; 3 2" apart.
o Black dot = Origin
o All on Layer zero

3. Draw the cabinets shown in Figure 4-2.2, plus:
a. The wall cabinets extend the full length of the room (14’-6").
b. The 3'-0" space will accommodate a refrigerator.
c. The countertop is at two heights; the sink area is lower for
handicap accessibility (covered more with interior elevations).
d. Add the two-compartment sink drawn in the previous step.
e. Ensure the sink is placed on the correct Layer (TIP: plumbing).

FYI:

The wall cabinets are shown with dashed linework in plan because they are
assumed to occur above the floor plan cut plane. This also helps to differentiate
between wall and base cabinets (the dashed line is controlled by the Layer).
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Figure 4-2.2 Drawing the break room casework

4. Draw the cabinets shown in Figure 4-2.3, plus:
a. The wall cabinets are 14” deep.
b. The countertop is 25" deep.

Wall and Base cabinets in

|
|
|
|
| / copy room; added in this step.
| : A
|
|
|

,77@77”

[
Figure 4-2.3 Drawing the copy room casework
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Checkout Counter

In the previous steps you placed base and wall cabinets, now you will design
the checkout counter. The checkout counter is what is referred to as “custom
casework”. The base and wall cabinets can also be “custom casework” or
they can be ordered from a catalog (the latter being the less expensive
option).

Basically, “custom casework” is anything a local cabinet/woodworking shop
would build. Typically built in their shop and assembled on-site.

Custom casework gives the designer a wide range of functional and aesthetic
opportunities. As you can see in the Figure on the next page (Figure 4-2.4),
the angles and curves require a custom built solution; these shaped cabinets
are not found in a catalog of standard cabinets.

The cost associated with custom casework is, of course, higher than standard
- stock- items. When the client can afford custom, they have the opportunity
to get a more functional space in which to work. For example, a drawer can
be located wherever it is needed and a cubby can be made just the right size
to hold the companies “odd” sized shopping bags (which make for better use
of space and keeps the bags stacked neatly).

The checkout counter represents a drafting exercise where you have to draw
various angles and curves per the given instructions. It is easy to draw
linework in AutoCAD that kind of looks like what it should be, but it is the
designer/drafters responsibility to draw things accurately so things go
smoothly during construction. This type of structured drafting, no matter if
on your own time or in a classroom setting, will make you better prepared
and more efficient in the workplace. Your instructor may have you print the
checkout counter to scale and check it with an accurate drawing on
transparence paper.

5. Draw the checkout counter shown in Figure 4-2.4a, plus:

Draw all linework on A-Case layer.

The countertop is 36" deep.

The doors (i.e., gates) are 36" wide.

The exact location of the gates does not matter (visually close).

Do not draw the dimensions.

Trim the curved line at grid 5 and then draw the longer angled

line by “connecting-the-dots”; see Figure 4-2.4b.
i. Select the line and use Properties to determine the length

and angle (i.e., the “???” dimensions shown).

g. Notice the radius for the curved portion of the counter matches
the radius of the adjacent curved wall previously drawn; the
casework line is held back slightly from the face of the wall.

SO Q0T

TIP: Draw one side of the counter and then use Offset to create the
other side.

4-17
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Figure 4-2.4a

]

14-213/4

5 1 S

Drawing the checkout counter casework

4-18
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Thinking about sightlines again, looking at Figure 4-2.5, you can see the
sightlines that have been added show how the design of the counter
enhances the Librarian’s ability to monitor the adjacent spaces.
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Figure 4-2.5 Reviewing sightlines associated with the checkout counter

Checkout Counter Example Second floor view showing gate and accessible
checkout area with lower countertop.
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Exercise 4-3:
Stairs and Elevators

Introduction

In this exercise you will add the stairs and elevators. There are several things
to consider when drafting and designing these components within a building.
Similar to the plumbing fixtures, you will download the elevator drawings
from the internet.

Adding the Passenger Elevators

Elevators come in several models and sizes. In this tutorial you will be adding
two passenger elevators and a service elevator. Selecting the model and size
depends on several factors such as: expected number of passengers in a
given period of time, number of floors served, budget and speed to name a
few.

In this made-up library project, the passenger elevators will have high
quality finishes and are intended primarily for people (i.e., the public and
staff) and book carts. The service elevator is only accessible by staff and has
durable finishes to withstand large items being moved in and out on a
regular basis.

The following steps could aid in determining the elevator shaft size. However,
this information was previously given when you drew the walls.

Again, you will need access to the internet before proceeding with this
exercise.

1. Open your Internet Browser; this book uses MS Internet Explorer.
Next you will be instructed to browse to a major elevator manufacturer’s

website.

the URL www.thyssenkruppelevator.com and then press

% 2. Browse to the ThyssenKrupp Elevator website by entering
Enter (see Figure 4-3.1).

3. Click the Architect Direct link near the top of the webpage.

4. Now select the Drawings link (i.e., the large round button).
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- ThyssenKrupp Elevator--Home Page - Microsoft Internet Explorer
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Figure 4-3.1 Elevator manufacturer’s website

5. Scroll down and select SPF 30 — 3000 Ib. Capacity (Figure 4-3.2):

6. Click the icon under the label Drawings (see image below):

Architect Direct Pro
The following elevator models match your requirements. You may choose to review the
product infarmation, download drawings ar create your customized Thyssenkrupp
Elevator specification documents.

Model: Machine Type: TK Specs:

SFF 20 Geared * DA T =]

Click here _/
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Machine Room-Less Models

synergy H series 21 2100 Ib. Capacity
synergy H series 25 2500 Ib. Capacity
synergy H series 30 3000 Ib. Capacity
synergy H series 35 3500 Ib. Capacity
synergy H series 40 4000 Ib. Capacity
synergy H series 45 4500 Ib. Capacity
synergy H series 50 5000 Ib. Capacity
synergy H series 50H 5000 Ib. Capacity

Geared Traction Models Gearless Traction Models
SPF21 2100 lb. Capacity 2500 2500 Ib. Capacity

SPF 25 2500 Ib. Capacity 3000 3000 Ib. Capacity

— SPF 30 3000 Ib. Capacity 3500 3500 Ib. Capacity

SPF 35 3500 Ib. Capacity 4000 4000 Ib. Capacity

SPF 40 4000 Ib. Capacity

SPF45 4500 Ib. Capacity

SPF 50 5000 Ib. Capacity

Macintosh users: Architect Direct Pro reguires the use of OS5 10.4 and Safari 2.0.2.
Mead Assistance? Contact your local TKE Representative st (877) 220.0202

€ Internet 0w v

Figure 4-3.2 Elevator manufacturer’s website

7. Right-click the DWG icon next to Hoistway & MR + 200 (speed) as
shown in Figure 4-3.3. FYI: You want the Center Opening option.

ThyssenKrupp Elevator
Armericas Business Unit

Architect Direct Pro
Basic Traffic Analysis

DirectSpec & Drawings

Product MASTERSPEC® i = ' —‘_""\

Escalator Specifications . .
Right-Click here

to download the

drawings

Section View 200

Hoistway & MR Center Opening 200 Front
Section View 350 Front
Hoistway & MR Center Opening 350 Front
Cartinn Wiew &n Frant

Figure 4-3.3 Elevator manufacturer’s website
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8. Click the Save Target As... command (Figure 4-3.4) and browse to
your My Documents folder.

SPF 30
Geared
Door Type Email
Section View 200 Email
Hoistway & MR Center Opening 200 . Fmail
Open Link
Section View 350 Front ]
Open Link in Mew Tab
Hoistway & MR Center Opening 350 Front E'; Cpen Link in Mew Window
Section View 450 Front E‘E Save Target As.. b
. . Print Target
Hoistway & MR Center Opening 450 Front El:.

Figure 4-3.4 File Download dialog

You now have an AutoCAD drawing file named SS041.DWG saved on your
computer’s hard drive. This drawing is shown in Figure 4-3.5, and is packed
with information. As you can see, details about the elevator shaft and the
elevator machine room are given. In your case, this is more information than
you need. So, you will open the drawing and Copy/Paste what you need into

your floor plan.
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Figure 4-3.5 Contents of drawing file just downloaded
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9. Open SS041.DWG (the elevator drawing just downloaded).

10. Zoom in to the elevator shaft plan view on the right.

Layer Freeze: a useful tool

Next you will use a tool to freeze a Layer just by selecting objects on the
screen. This will help you to select just the parts of the drawing you need.

11. Set the current Layer to O (i.e., zero).

TIP: Click the Layer drop-down list from the Home tab and scroll up to
Layer zero and click on it; as long as nothing in the drawing is selected, this
will make the selected Layer current.

12. From the Layers pane on the Home tab, select the Freeze icon.

Layer
Properties

£2 Unsaved Layer State v g = =
= v A o
£

T TEXT Z o

Layers 4

13. Click on all the text, dimensions and centerlines until the drawing

looks like Figure 4-3.6.

TIP: If you click on the wrong object and a Layer is frozen by mistake, type
U and press Enter on the keyboard. (This is not the main Undo command.)

T

—= L [ <

]
T4 —|_1— 1

Lr j— p—

Figure 4-3.6 Elevator drawing

The elevator drawing is almost ready to
be copied to the clipboard and pasted
into your floor plan.

Before you copy the drawing to the
clipboard, you will fix the broken lines
(they were trimmed to accommodate
notes and dimensions - which are now
frozen).

Also, all the visible linework is currently
on a Layer named “Object” which does
not conform to your office standards;
you will fix this too.

424
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Using the Join Command Q
g 2, [BORE

The join command allows you to select two or * & S =

more aligned lines and turn them into a single Move ==

line. You will try this next.

EI oo
14. Select Join from the extended portion of
the Modify pane, on the Home tab. e

o =
15. Select the three lines identified in bR _
Figure 4-3.7 and then press Enter. Maodify

== @

Select these three lines M

using the Join command

-

Figure 4-3.7 Elevator shaft drawing

] B

16. Continue to use the Join T 1@
command to cleanup all
three sides of the elevator L
car as shown in _— I —

Figure 4-3.8.

In the next step you will change all
the linework to Layer zero before
you copy/paste into your floor plan.
If you did not do this the Layer
named “Object” would be created in L F p—

your floor plan drawing. These types
of extra Layers are not desirable.

1 §
17. Select everything visible in N K
Figure 4-3.8 and change its
Layer to 0 (i.e., zero). Figure 4-3.8  Elevator shaft drawing
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Next you will mirror the elevator to align
the orientation with your plan.

18. Mirror the elevator as shown in

Figure 4-3.9. o

Copy with Base Point

Next you will Copy the elevator to the
MS Windows Clipboard. This is a
placeholder for information (it can be

—||"
used within the same application or 1

between programs, e.g., Copy from

\

\
AutoCAD and Paste into MS Word). } Xr
| SN

AutoCAD offers the ability to specify a L

Base Point before placing the drawing Figure 4-3.9

information in the Clipboard. Thus, when
you Paste the drawing information back

Elevator mirrored

into the same drawing or another drawing
you can accurately place it.

19. Select Copy with Base Point from
the Utilities pane, on the Home tab.

You are now prompted to select a Base Point:

20. Pick the point identified by the black
dot in Figure 4-3.9.

Utilitis

You are now prompted to select items to copy to the clipboard:

21. Select everything in Figure 4-3.9 except the walls which have been

shown dashed for clarity (you already have walls in your plan).

TIP: You can use a crossing-window to select everything and then hold

down the Shift key while selecting the wall lines (which will remove them

from the selection set).

22. With everything but the wall lines selected, press Enter.

The elevator has now been copied to the clipboard. That information will
remain there until the computer is turned off or AutoCAD (or any other

program) copies new information to the clipboard.

Try this:

While the drawing data is still in the clipboard, try opening a word processor like
MS Word and select Paste from the Home tab on the Ribbon. Notice how the
drawing looks in the document (also notice the down-arrow & Paste Special).
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Switch back to your library floor plan.
24. Zoom in on the elevator shaft near the main entry.
25. From the Utilities pane, select the Paste icon (or Ctrl + V).

You should now see a ghost image of the elevator attached to your cursor.
The Base Point previously select is now the insertion point.

26. Select the same, relative, location as the insertion point (shown as a
black dot in Figure 4-3.10).

@

|l

Figure 4-3.10 Elevator inserted into your floor plan (black dot in lower-left for reference only)

You now have one of the two elevator cars located within the shaft. In this
plan you will have two elevators in the same shaft, separated only by a beam
at each floor. So you still need to mirror the car and trim the wall lines at the
elevator door opening.

27. Use the Mirror command to copy a mirror image of the elevator car
to the opposite side of the shaft (see Figure 4-3.11).

TIP: Use the midpoint of one of the vertical wall lines to establish the
Mirror Line (with ORTHO on).

28. Trim the wall lines and place the jamb lines on A-wall layer (not the
elevator frame, just the line that closes off the wall); see Figure 4-
3.11.

29. Move all the elevator lines to the proper layer (see Appendix A).
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The Weight of Finishes?

Finishes are very important for several reasons
when it comes to elevators. As previously
mentioned the use needs to be considered
(passenger or service); this will dictate the
durability and cost of the finishes.

Another consideration is the weight of the
material. If the Interior Designer selects wood
wall panels and tile flooring (which is perfectly
acceptable) the elevator manufacturer needs
to know how much these materials will weigh
so they can properly size the motor for
optimum performance.

So, similar to coordinating with the Electrical
Engineer at casework locations, coordination
must also occur with many other items in the
building that the Architect or Interior Designer
is directly responsible for.

30. Add two lines, 4" apart, between the
elevators to represent a beam; place
the lines on the same Layer as the
elevator.

.

T

L4

E
E

rr

Lk

L

Figure 4-3.11

Elevator added to plan

Your elevator should now look like Figure 4-
3.11. Several details are drawn, such as the
guide rail, the cab door, the floor level door
and even the pit ladder.

Many architectural firms have a copy of the
major elevator manufacturers’ technical
catalogs which provide enough information to
manually draw everything in Figure 4-3.11. But
it is not difficult to see how the internet can
save time when AutoCAD content is available;
not all manufacturers provide AutoCAD
drawings of their products.
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Adding the Service Elevator

This elevator is near the loading dock area (west side of the building) and is
only accessible by the library staff. It is rated for a higher capacity than the
passenger cars (3000Ibs. vs. 5000lbs.). The cab size is also larger to make it
easier to move objects in and out.

You will be given minimal information with the expectation that you use the
knowledge previously learned to locate and insert the drawing data.

31. Place the service elevator per Figure 4-3.12, plus:
Use the same mfr: ThyssenKrupp Elevator
Type of application: Traction geared
Capacity: 5000

Model SPF 50

Note the door orientation.

Do oo

(L)
Cl '

_ —— _ _ _

—— — —
| |

Figure 4-3.12 Service elevator added to plan
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Adding the Open Stair

The open stair is the primary stair used for vertical circulation in a building.
This type of stair offers visual way-finding and can make an aesthetic
statement for the building when located and designed well. Building codes
often allow an open stair between two floors only; if one wishes to have a
multi-story open stair it must have the ability to be closed off, which usually
means overhead door-like fire shutters that will be lowered in the case of a
fire.

Below is an example of a well designed multi-story open stair. The railings
are glass with a wood cap, the treads and risers are high quality terrazzo and
the walls are lined with wood panels. The stair is located next to windows
which help the users know where they are in the building relative to the
outside (helps with way-finding). The photo was taken through a large piece
of glass that makes the stair visible at each floor within the building; in the
event of a fire the fire-shutters come down and close off this view!

Open Stair Example High quality stair with interesting design
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32. Draw the open stair per Figure 4-3.13, plus:
a. The tread lines are 13" apart.
b. Draw the treads on Layer A-Flor-Strs.
c. The railings are to be drawn 2” wide and 2" out from the wall.
d. The railings that are not continuous extend past the top/bottom
riser by 12" and return to the wall.
Draw the railings on Layer A-Flor-Hral.
The dashed lines represent the stairs and floor opening above
the floor plan cut line.
g. Draw the dashed lines on Layer A-Flor-Strs-Abov.
h. Draw the arrow manually; you will learn a better way later.
TIP: Use lines and a solid hatch for this
i. Use the Donut command to make the black dot (type the word
“donut” in the Command Window).
TIP: Set the inside radius to 0” and the outside to 4”.
j. Add the text (per standards for 1/8” scale; 9” high).
k. Draw text and arrow on Layer A-Flor-Strs.
I. Do not draw the dimensions.
m. Draw the angled line shown on the stair Layer.

o

il
B0 =G
Wv 25’—7”I
RN _
~—
i T o
;‘r \
-
\
Aﬁ‘p fffff -
-
L]
Tr up
E— e (1)

Figure 4-3.13 Open stair to be drawn
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The angled line that trims the tread lines in Figure 4-3.13 represents the cut-
line of the floor plan. The location of this line is not too critical, it is best to
place it where the major features of the stair can still be shown. Depending
on the distance between floor levels, you might have a significant space
below the stair and need to show seating or flooring patterns. Codes require
the lower portions of the stair (i.e., under the stair) to be enclosed so the
visually impaired do not run into the stair. Sometimes it is desirable to
enclose the underside of the stair completely to avoid hard-to-clean spaces;
in this case you might see a wall pickup on the other side of the cut line.
Even though the stair reached up past the cut line, the wall resting on the
floor still continues for the length of the stair.

The image to the left is showing,
three-dimensionally, how the floor
plan cut plane impacts a stair which
has a wall under it. In plan view, the
break-line is added where the stair
extends above the cut-plane;
beyond the cut-plane you would
show the wall below the stair
because it is now passing through
the cut-plane.

The handrail extension is dictated by the building code. The same is true with
the handrails returning to the wall; this prevents people exiting the building
(or fire fighters entering) from getting entangled with the handrails. The
figure below (3.3.14) shows an elevation view of a wall mounted handrail to
help you better understand what you are drawing.

WALL MOUNTED —%
HANDRAIL SYSTEM <”>
AV

:I),—D"

TREAD COUNT VARIES -
SEE STAIR SECTIONS

Figure 4-3.14 Handrail detail

In this floor plan, you would most likely add furring to the south wall to cover
the structural concrete column (not required for this tutorial).
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Adding the Utilitarian Stairs

The two utilitarian stairs
are almost identical; this
is ideal whenever possible
because it reduces the
number of stair sections
and details that are
required in the
construction documents.

As already discussed, the
utilitarian stairs are not
readily visible and
primarily meant for
emergency egress; their
existence is primarily
dictated by code. They
are, however, often used
as a means of vertical
circulation within the
building.

The finishes and light
fixtures are simple - often
painted CMU walls and
surface mounted lights.

Utilitarian Stair Example
Durable, average cost stair with simple design

33. Following the same instructions as the previous step, draw the east
stair per Figure 4-3.15, plus
a. Draw the inside handrail 2” in from the stair edge (see photo).
b. Draw two angled break lines with void between.
C. The tread lines are 11" apart.

Notice in Figure 4-3.15 that the angled break lines help to delineate both the
up run and the down run, which would otherwise overlap and be confusing.

34. Using Copy (or Copy to clipboard) and Mirror, copy the east stair into
the west stair shaft (see Figure 4-3.16).
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ﬁllD’—‘]”

Figure 4-3.15 East utility stair shaft

Why two walls at the exterior walls in the stair shaft? This is a
problem that requires the ability to think three-dimensionally. It should be
obvious to you that a beam spans between two columns; typically at each
floor level and at the roof. Well, the stair shaft is a tall room that passes
multiple floors. Thus, the stair shaft needs to occur outside the beam line,
which is centered on the column/grid lines.
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EW —

=

|
| | |

Figure 4-3.16 West utility stair shaft

If you were drawing the other floors in this building you would Copy/Paste
the stairs to the other drawings; the upper floor and basement would need to
be modified.

4-35



Commercial Design using AutoCAD 2009

In stairs, building codes often require a gate at
the ground level and at the upper level (if the
stair continues to the roof) as shown in the
photo below. The reason for this is to help guide
people in an emergency. Each floor in the
utilitarian stair shaft looks the same, so it would
be easy for a person (especially in a panicked
state) to pass the ground level exit and continue
down one or two more floors to the basement;
extending their time in a dangerous situation. If
the stair is used for normal, day-to-day, vertical
circulation, some building officials will allow the
gate to be placed on a magnetic hold-open
which allows the gate to close in the event of a
fire.

Most commercial codes also require that a sphere 4” or larger not be able to
pass through the guardrail. This has a large impact on design but creates a
safe environment for the users; looking that the photo above it is not difficult
to see how older codes allowed for unsafe designs!

Also notice, in the photo below, that the handrails return to the guardrail or
the wall as previously discussed.
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Exercise 4-4:
Annotations

Introduction

This exercise involves adding room names and numbers, as well as each
room’s square footage. The square footage will be added via an AutoCAD
feature called Fields, which will update automatically when a room changes!

Room Numbering

Room numbers typically start at the main entry and then proceed in a logical
direction (e.g., clockwise). Sometimes the numbering is coordinated with the
signage schedule (i.e., the rooms that are not numbered on a sign get
skipped until the end numbers).

You will start the room numbering at the main entry and work in a clockwise
direction. Later, you will use this information to generate a room finish
schedule.

Room numbers will be three digits, with the first number corresponding to
the floor that room is on. For example, the janitor’'s closet on the first floor
might be 134 and the janitor’s closet on the third floor might be 312.

Room Square Footage

To get the square footage, one can draw a Polyline and use the Area
command to list its square footage. Specifically, draw a continuous Polyline
(pline) using Object Snaps, before picking the last point (i.e., the starting
point) type C for close to create a Closed Polyline; and then type Area and
select the polyline - the square inches and square foot will be listed. The
polyline can be placed on Layer A-Area-Bdry and turned off for future
reference (e.g., the room size changes and you need to update the area).

The text for the room names will be AutoCAD Style Bold per the “office
standards” (see appendix A). The room name and number will be 12" high
and the square footage text will be 9” high. All the text (name, number, sf)
shall all be in one Mtext object (i.e., typed all at once - not three separate
commands). Just like working in a word processor, you can select a portion
of text and edit its properties — this is how you have two text heights in one
Mtext object.

1. Use the Style command to set up the “"Bold” AutoCAD Text Style in
your floor plan drawing. (See Appendix, page A-14, for more
information.)
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2. Create the Layer for your “area” polylines (see Appendix for Layer
name and color).

3. Set the new area Layer to be current.

Next you will draw a Polyline to create an enclosed area for each room. A
Polyline is a special line in AutoCAD that can contain several straight line
segments that are all connected together. When a Polyline is used, you can
see how many square feet are contained with the enclosed area as well as
the length of the perimeter. These values are very
helpful for estimating quantities and project costs.

4. Using the Polyline command (see image
% to the right), draw an enclosed area in the

Vestibule as shown in Figure 4-4.1.

TIP: Start the Polyline command, and start picking points (all the inside
and outside corners of the room, a.k.a., the finished face of the room).

TIP: Instead of clicking the last point directly (i.e., clicking on the first
point), simply type C (for Close) and AutoCAD will finish the Polyline for
you. This will make sure that the Polyline is truly closed, which is important
for getting the square footage and hatching.

| ‘ e o A8 B %}@

Figure 4-4.1 Adding a polyline at the vestibule
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5. Select the Polyline created

in the previous step. fo| |Polvine
= [General »
6. Right-click and select Color B ByLayer
Properties from the pop- L A-frea-Bary
Linetype Eﬂ.ayer
Up menu. Linetype scale 1.0000
Plok skyle EyCalor
7. Notice the Area and Linswsight ByLayer
Length (which is the _H:_PE;“““
Perimeter in this case) | L = .
ae [ : 3D Visualization £
properties listed (Figure 4- " Waterial B
4.2). Geometry -
Vertex 1
The Area property lists square Vertex ¥ 202'-7"
inches and square feet; square o 227
. . . Start seqgrent width  [g"
inch is not very useful, but it is the = : -
X i nd segrent width |y
default unit for architectural o =
drawings. Elevation o
Area 920364047 sq. in. (6391417 sq. Ft.)
Note that a Polyline does not have [ Bl
to be closed; it could be a curb for  |E| MeE ; =
. [=]
the length of a road or an irregular s o s R
line representing the transition

between two floor finishes.
Figure 4-4.2 Polyline properties
8. Press Escape to unselect
the Polyline.

Now you will use the Mtext command to add the room number, nhame and
square footage. The square footage information will be added by placing a
Field in the Mtext editor, which automatically gets the area from the Polyline.

9. Add the text to the Vestibule as shown (as Multiline Text) in
Figure 4-4.3, plus:
Place text on Layer A-Area-Iden.
Style: Bold.
Room name and number: 12" high.
All text in one Mtext object; proceed to the next step; do not
exit the Mtext edit mode.

anoco
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Figure 4-4.3
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Inserting Fields

While still in text edit mode, press

Enter to start a third line.

Right-click to access the pop-up

menu.

Select Insert field...
(Figure 4-4.4).

You are now in the Field dialog box (Figure
4-4.5) where you specify what type of
information you what this specific Field to
display. You can have things like the date,

file name and much more, and they

automatically update if they change.
NOTE: One Field object only holds one piece of
information, but you can add as many Fields as

required.

4-40

J 1l

Adding vestibule number and name

\Eﬂ»l
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Paste Special

Symbol ! g 3

Import Text...

Patagraph Alignment [3
Paragraph...
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Columns 3
Find and Replace...  Ctrl+R
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Character Set 3
2H0sf ;
|
1 02 Background Mask. .,
VVOMEN: Editor Settings 13
Learn about MTEXT L4
! 72sf
| Cancel

Figure 4-4.4 Adding a field
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13. Under Field category, select Objects (Figure 4-4.5).
14. Under Field names, click Object (Figure 4-4.5).

15. Under Object type, click the Select object button (Figure 4-4.5).

Formula

MamedObject - \_ -
M| Select object button.

Click here to select polyline
in the current drawing

il b At o M _‘*m gl _m.‘-#—'-—--. = A g ’--ﬁ"--uﬂ-""
Figure 4-4.5 Field dialog box

Field category: = Object type: : - Previsn:

Objects (1) & | [\@J EREEEE i
Field names: - Froperty: \!:Drmat: .
BlockPlaceholder |

16. Select the Polyline drawn at the perimeter of the vestibule; you
can Zoom in/out using the scroll wheel on the mouse, if needed.

As soon as you select the Polyline you are returned to the Field dialog box.
Notice that the Object type is listed as Polyline; this is a good way to make
sure you selected the correct object. (If it listed Line rather than Polyline,
that would mean you accidentally picked a wall or grid line.)

17. Select Architectural under Format and set the Precision to 0.
Notice the Preview changes (Figure 4-4.6).

Field category; Chiject type: Preview:

. 1 | 1
|Objects v! | Palyline | @] | 639 50, FT.
Field names: Farmat:

Properky: =
BlockPlaceholder I 1 nonek
Current units
Farrmula Closed Decimal )
LR S ErE—2 —
I Elevation | Engineering

Global width

Eavis | Fractional
FaaHs Scientific
Linetype

Linekype generation L
Linetype scale F‘reusmn. Py

Lineweight '_‘E}F
Material —_——— T—
Object name

Plat style
Thickness

Additional Format. ..

e+ o i ‘_‘u' *"\-ﬂ‘n I R e L

Figure 4-4.6 Field dialog box; polyline selected
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18. Click OK to close the dialog and add the Field to the Mtext.

The area of the Polyline is now displayed in a shaded rectangle (Figure 4-
4.7). The shaded rectangle does not print; it is displayed on the screen so
you can easily tell the difference between regular text and Fields.

S g g -

Figure 4-4.7 Field added to Mtext object

@

20

The last thing you need to do is adjust the size of the area text. It could be
left as-is, but it will look better if it is a little smaller than the other text.

19. Click anywhere on the Field object and the entire Field
will select. Set the text height: 9" on the Ribbon.

20. Click Close Text Editor to finish the Mtext object.

X

Close
Text Editar

Closs

As you can see, the Mtext object can contain various text heights and Fields.
This is helpful when you want to move the text; you only have to select one

thing to move rather than three (in this example).

100

VESTIBULE
639 SQ. FT.
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Next you will take a quick look at how the Field information updates when
the Polyline is modified. Before proceeding, you will undo these changes.

21. Stretch the interior wall and doors per the following tips:

a. Make sure the A-Area-Bdry Layer is on and the Polyline is
visible (you want the Polyline to be stretched).

b. Select the Stretch icon from the Modify pane.

c. Pick a Crossing Window (picking from right to left) as shown
in Figure 4-4.8, being careful not to include the C/6 column’s
insertion point within the Crossing Window.

d. Select the two displacement points: First, pick the lower left
area of the selected objects, and then pick the outside corner
(to the left) of the wall you are trying to align the doors with.

_ E| l:_ - :|l .|i|! _IYI _ IY&_::_ _@

1!

1 1= — .

I Original walls and

| I Lo 7 doors shown dashed
| |=|“ ~ for reference only |
11

} I 100
IL4=|— VESTIBULE |
=7 639 SQ. FT.
-

7 17
| | —__ | Crossing Window for

= == stretch command.
. Eﬁ |
(L

= J T«

Figure 4-4.8 Stretching the vestibule wall

After stretching the Polyline you will notice the square footage did not update
yet. The Field information is correct, but the graphic representation has not
updated yet. The graphics are updated by a drawing regeneration, plotting
and/or closing and reopening the drawing.
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22. Type Regen in the Command Window.

Notice in Figure 4-4.9 that the Field is now updated!

100
VESTIBULE

/
I
/ 890 SQ. FT.
\
= - e ) S _@

Figure 4-4.9 Field information updated automatically

M

23. Click the Undo icon twice (once for the Regen and once for the
Stretch).
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Practice makes perfect...

You will repeat the previous steps to add the room information to each
space. The steps are pretty simple: (1) draw the Polyline, (2) create the
Mtext, and (3) insert the Field before closing the Mtext.

Next, you will be given several plan views with all the room names, numbers
and square footages (shaded rectangle for Fields is not visible in these
views). If you have trouble reading the area numbers, don’t worry as the
field object will fill it in automatically; they do serve as a double-check to
make sure you drew the rooms correctly.

24. Per the previous instruction: create a Polyline and add the room
information (as Mtext + Field) for the remaining rooms, as shown in
Figures 4-4.10 through 4-4.13; you may ignore the areas not
labeled.

The text location can vary in each room, but the ideal location is centered in
the room and aligned with adjacent room labels. These locations get moved
as the plans develop, so the text does not overlap furniture/notes/
dimensions/etc.

25. Freeze the Layer A-Area-Bdry to make the Polylines disappear.

The Fields will still reference the Polylines even when they are on a frozen
Layer. However, you need to remember to thaw this Layer before stretching
or modifying any walls if you want the area to update automatically.

Once you get one room label set up with the properly formatted text (i.e.,
12" and 9” high text) you can copy that one, with ORTHO on, into other
rooms. Once copied, you can double-click on the text to open it in the Mtext
editor. Then you can edit the regular text and right-click on the Field to
select Edit Field, which will allow you to select another Polyline. (If you do
not edit the Field, it will continue to list the area of the previous space.)
Using ORTHO (toggle icon located on the Status Bar) helps to keep the text
aligned horizontally or vertically.
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Figure 4-4;10 Adding room information
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Figure 4-4.11 Adding room information
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Figure 4-4.12 Adding room information
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Figure 4-4.13 Adding room information
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Exercise 4-5:

Presentation Graphics: Solid Filled Walls

Introduction

The walls are often filled solid during the Schematic Design and Design
Development phases so the walls punch out better when presented to the
client. This is done using the Hatch command and the hatching is placed on
a special Layer that can be turned off as the plan develops (into the
Construction Documents phase).

One of the many unspoken rules in many design firms is that hatching should
be limited to only a few (or one large) areas. For example, when using the
Boundaries: Pick Points feature of the Hatch command (a feature that
automatically finds the boundary of an area by picking a point anywhere
within the enclosed area) you need to limit how many points you pick at one
time, or make sure you check the "make separate hatches” check box.

Otherwise, you might hatch half the plan which would be a single entity. If
you need to change one little area (e.g., a wall moves 1” to the west) you
would have to erase the hatch and recreate the hatching for half the plan.

Another thing to be careful of is not to create too many “little” hatches in one
area. For example, if you do check “"make separate hatches”, each click of
the mouse creates a separate hatch. So if grid lines and break lines cross an
area of wall it would be better if that hatch was one object rather than
several small hatches that look like one.

Don’t forget the power of the Block! If you had to add a solid fill to the
structural columns, you could simply double-click on one of the columns to
open it in the Block Editor (as instructed in Lesson 3), add the hatch and
save/redefine the Block. All the columns will automatically be updated! Make
sure the hatch is placed on a separate Layer so its visibility can be controlled
independently from the column itself. Now you will hatch all the walls with a
solid hatch; placing the hatch on a special Layer.
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Looking at Figure 4-5.1 you can see it would take three picks just to Hatch
the area between the two windows. Also, the grid lines bisect several walls
which would require several extra picks as well. This is one of the main
reasons for dividing things up onto separate Layers, so you can turn them off
when they are not needed.

1. Using the Layer Off tool from the Layers pane (Home tab), s
w turn off the grid lines and the wall cavity lines (Figure 4-5.1). :

Notice how the Layer Off tool was able to turn off the grid line Layer even
though it was part of an external reference!

MECH
SHAFT
T
105
CLASSROOM
645sf
P DN
106 \
I e

Figure 4-5.1 Plan view near east stair shaft

Notice the floor plan in Figure 4-5.2; the walls are now uninterrupted and
ready to be hatched.
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Figure 4-5.2 Plan view near east stair shaft — layers turned off

Next you will create a Layer to place the wall Hatch on.

2. Create Layer A-Wall-Patt-Temp (color red) and set it current.
a. If you want the hatch to be a shade rather than solid black you
can set the Layer color to 253 or 254.

With the Layer set current, all Hatching will be placed on the proper Layer -
avoiding the need to select the Hatch and switch its Layer after it has been
drawn.

3. Select the Hatch icon on the Draw pane =
or type H and Enter on the keyboard.

4. Set the hatch Pattern to Solid (Figure 4-5.3).

5. In the Options area (Figure 4-5.3):
a. Check Associative.
b. Check Create separate hatches.
c. Set the Draw Order option to Send behind boundary.

FYI:

The Associative feature of the Hatch command can be very handy. When it is
checked, AutoCAD remembers the boundary that was used to create the hatch,
and if the boundary changes that hatch is updated. So if you stretch a wall 12” to
the east the hatching will update automatically. If any part of the boundary gets
erased the associativity will be lost.
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I'Y Hatch and Gradient E|
[Hatch | Gradient Boundaries
Type and pattern Add: Pick points
Tepe: Predefined v
=3 AT e Add: Select objects
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Cirays arder:
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() Specified origin
B}
T T
--
+

[ Cancel ] [ Help ]@

Figure 4-5.3 Hatch dialog box

6. Click Add: Pick points, and then begin clicking within walls to select
areas (they will highlight as you select them); press Enter and then
click OK to close the hatch dialog box. TIP: Even with "create separate
hatches” checked you should still limit the number of areas you select at
once to avoid messing up and having to start all over again.

a. Do not hatch the concrete columns at this time

7. Continue the hatching process until all walls are hatched.
a. Again, do not hatch the concrete columns at this time

As you can see in Figure 4-5.4 the walls and window punch out very well

compared to Figure 4-5.1. This is also true for items like casework and
furniture; they read better!
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Figure 4-5.4 Plan view near east stair shaft with walls hatched

Once you get all the walls hatched you will want to turn the grid lines and
wall cavity lines back on. There are two ways to do this quickly.

e If you have not made any other Layer manipulations or closed
AutoCAD, you can simply click the Layer Previous icon. E

e Another method is to open the Layer Manager and right-click on any
Layer name and click “Select All” from the pop-up menu. Then you
can click any Layer icon that is “off” and all Layers will be turned “on”
(see Figure 4-5.5).

8. Using one of the methods just described, restore the visibility of the
A-Wall-Cvty and DJS55803AGDO01|A-Grid Layers

Your drawing should now look like Figure 4-5.7.
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Figure 4-5.5

Layer Manager; right-click and pick “select all”

Take a moment and notice the other tools available in the right-click pop-up
menu shown in Figure 4-5.5.

In the text box in the upper right of the Layer Manager (that has the light
gray words “Search for layer”; see Figure 4-5.5) you can type something like
*grid* and see only the Layers that have the letter/word “grid” in them
(e.g., A-Grid, A-Grid-Iden, DJSAGDO01|S-Grid, etc). See Figure 4-5.6 below
for an example where only the Layers with the word “wall” are listed.

I:( .C.urrent.layer: E—E‘rea-é;:iry . Dimensions il x
»
=<5 LEX v B &
,_:’-} Filters « || 5., Mame .. Fre... L. Caolor Linetype Lineveight Plot5... | P... M.. Description,
[=R="3 <o A-WALL " @ 73 [ green Continuous Default & 1 walls
3 all Used Layers = A-Wall-Cuty ", (:l 5 Continuous Default E&q .1 wall caviglf lines (i.e. inner lines)
Eﬂ‘g 3] @Xraf %= A-Wall-Patt-Temp # My W ored Continuous Default 2 T walls
[}
B
-]
=
@
=
=]
=
=4
E Displays layers and layer filters and their properties and descriptions. |
o
8 || Trwert fiter «||¢ [ZJPress F1 for more help | >
™
-
g All: 3 layers displayed of 51 tatal layers

Figure 4-5.6

Layer Manager; search for “wall” layers

Later in this book you will learn about another feature called Layer States;
which allow you to create “named” Layer States to control the visibility of
Layers. Thus, you can quickly toggle between a presentation type drawing
(i.e., minimal notes, dimensions and solid hatching in the walls) to
construction documents (i.e., notes and dimensions visible, and solid wall
hatching turned off).
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Overall floor plan with walls filled solid

Figure 4-5.7
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Self-Exam:
The following questions can be used as a way to check your knowledge of this
lesson. The answers can be found at the bottom of this page.

1.

2.

All drawing data downloaded from the internet is perfect. (T/F)
Sightlines are important in toilet room designs. (T/F)
Right-click a Layer name to select all Layers in Layer Manager. (T/F)

The handrails for the stairs go on layer.

Which hatch feature saves you from having to re-hatch an area when you
stretch a wall to a new location?

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

1.

2.

10.

Toilet partitions are typically drawn 1” thick. (T/F)
Countertops are drawn 25" for a 24" deep base cabinet. (T/F)
Wall cabinets are shown with dashed lines in floor plans. (T/F)

The Layer Previous icon restores the condition of any Layers from the last
time they were changed (T/F)

You can Copy/Paste items between drawings. (T/F)

In the Layer Manager, you can modify the list of layers to just show the
Layers that just have “door” in them? (T/F).

What did you draw in order to list a room’s area?

What command mends two lines together?

What command lets you freeze a Layer by selecting an object on screen?

You can only have one text height within an Mtext object. (T/F)

Self-Exam Answers:
1-F,2-T,3-T,4-A-Flor-Hral, 5 — Associative
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